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Final Training Plan – Appendix C – Style Guide
1. Introduction

1.1 Purpose

This document outlines the standard approach, tone, voice, labels, documentation/module flow, terminology, language, etc. that will be used in the creation of the training print and e-learning deliverables that will be used during the implementation and stabilization phases of the project. The objectives of this document are to:
· Identify the deliverables that will be impacted by the standards in the Style Guide

· List the items, objects, etc. that require standardization 

· Document the specifics for each item, object, etc.
1.2 Scope

The deliverables impacted by the standards in this guide are:

· Participant guides

· Instructor guides

· Captivate simulations

· Storyboards

· PowerPoint slides

· Job Aids

1.3 Style Guide Users

The Style Guide users are the EDS and EOHHS documentation and training teams.
1.4 Approach

EOHHS Training Manager will develop the content of this guide, and review it with EDS.  The EDS Training Team will be responsible for editing and updating the document.  

1.5 Approval process

Developed by:  

EOHHS Training Manager 
Reviewed by:

Lynn Andrews, Director of Change Management, EOHHS
Karen Jones, Functional Manager, EDS
Approved by:

Lynn Andrews, Director of Change Management, EOHHS
1.6 Roadmap

There are no RFR requirements for the creation of a training style guide.  This document is in response to the preliminary training plan section 3.2 indicating that a style guide was to be created to support training materials development.
2. Style Guide Specifics for Print Material (Instructor’s Manual, Participants Guide, Job Aids)
2.1 Styles

The templates for each product (Participant’s Guide, Instructor’s Guide, Captivate simulation, etc.) will drive styles pertaining to fonts, spacing, headers/footers, etc.

2.2 Titles

The titles of Modules should be in the plural form. 
For example: Adding Members, not Adding a Member.  
The titles of Modules, Walkthroughs, and Exercises should be in the singular form. 
For example: Entering a New Provider Address. 
The titles should be included for Modules, Walkthroughs, and Exercises.  Additionally, they should be at the top of each continuing page.  

For Example:  
4.1 – Module: Entering a New Provider Address
4.1 – Walkthrough: Entering a New Provider Address
4.1 – Exercise: Entering a New Provider Address
4.1 – Exercise: Entering a New Provider Address (cont.)

For exercise titles that are two or more lines long, use a hanging indent.  
For Example:  4.1 – Exercise:  Entering a New Provider Address for a Provider that has Affiliations with Several Medical Facilities
2.3 Performance Objectives
2.3.1 General Guidelines
· Objectives indicate the expected outcome of what the learner will be able to do after training.

· Objectives should be specific (not open to multiple interpretations).

· Objectives should be brief (no more than one sentence).

· Objectives should describe observable or tangible behavior (you could see the person doing it).

Suggested Action Verbs

	Enter

Process

View

Change

Add
	Assign

Verify

Update

Set up


Verbs to Avoid

	Know
	Understand


2.3.2 Module/Job Aid Introductions vs. Objectives

· Module and job aid introductions describe what the module/job aid is about—what the content is.  These introductions can include answers to the following questions:

· Why do I need this module/job aid?

· How can it be helpful to me?

· Is this only to be used for specific situations?

· Also, for a job aid that describes a long procedure, the introduction can give a broad outline of the major steps in the procedure

· Objectives describe what the learner will be able to do after completing the course.
2.4 Screen Settings

Your display settings should be:

· Color Quality:  Highest (32 bit)
· Screen Resolution:  1024 x 768 pixels
· Font Size:  Normal
2.5 Screen Shots

Standardize the introduction of a screen shot with the following sentence: 

Your screen will appear similar to the following.
Use a caption for each screen shot if the name of the panel group or subpanel is not used in the sentence preceding the screen shot.  The caption should be in title case form, centered, italicized, and include the panel and/or subpanel name.   (Or, in the case of a blank window, use the window name.) Also, use a caption to describe any business process flow diagrams/inserts.

Screen shots containing populated information should be inserted after the steps where the user is asked to enter that information.  The following is an example demonstrating both the introductory sentence and captioning.  It picks up mid-stream in a Walkthrough:

5. ATN: Type “12345667812”.

6. Status: Select “Approved”.

Your screen will appear similar to the following:
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Provider Application – Application Base Information
Note:  Do not use the word “panel” or “window” in the caption, unless it is part of the title.
2.6 Capturing Screen Shots

The SnagIt software package will be used for capturing screen shots. Use SnagIt to capture panels, dialog boxes, menus, etc.  
To take screen captures with SnagIt, select Capture Profile in the left pane to select what you want to capture, then select the Capture button. The capture will be displayed within the Preview Window, allowing you to view, edit, and enhance your capture. 

1. Select Capture Profile. The Region to File should be used if you are capturing a screen shot that will be used again.  Then you can save it to file.  The Region to Clipboard  should be used if you are capturing a screen shot to drop directly into your document.  When making any capture profile selection, the profile is highlighted by an orange bar.

2. Select the Capture button to begin the capture. The window disappears and you see a crosshair cursor. Drag the crosshairs across the screen to capture a region then release.

3. The capture displays in the Preview Window. From within this window, you can edit your capture using SnagIt's full range of options, including flipping, mirroring, shearing, rotating, cropping, and cutting. You can add custom edge effects such as drop shadow, torn or faded edges, and enhancements such as arrows, cursors, lines, text, and a whole lot more. You can also adjust the capture's color depth, edit text, or view the frames of a video capture.

4. Finish Capture. Select the Finish button to send the capture to the output. For easy reference, the output format is shown within the Finish button. In this example, the capture will be saved as a file.

5. Save as File. If you are going to use the screen capture again and wish to save it as a file, then in the Save As dialog box, enter the name of the file, select file format, and select OK.

SnagIt also allows you to capture screen shots too large to display on your monitor with the scrolling window features.  See the SnagIt online help for detailed descriptions of features, functions and options.
Note:  Hot keys used to capture whatever is on your screen, once SnagIt is open, are Ctrl-Shift-P for version 7.0 and Print Scrn key for version 8.0.

2.7 Terminology

“User” will be used instead of “End User” or “Student”

“Panel” and “Subpanel” will be used instead of “Screen”

“(Cont.)” will be used instead of “Continued.”
“Click” buttons – for example, Click Save.
“Click on” drop-down arrows – for example, Click on the Status drop-down arrow
“Click on” tabs – for example, Click on the Claims tab

“Click in” the text box – for example, Click in the Last Name box
“Press” keys – for example, Press [ENTER].
“Type” data – for example, Type “Smith”
“Select/Deselect” check boxes – for example, Select Individual 
The following are preferred spellings for other common terms:
setup (vs. set-up)

online (vs. on-line)

scrollbar (vs. scroll-bar)

double-click (vs. double click)

drop-down (vs. drop down)

2.8 Active Voice

To enhance learning, information should be presented in a simple, concise manner and should be consistent throughout the training materials.  Eliminate "nice to know" information; leave only the essence of a concept, rule, or procedure.   

Use the active voice rather than the passive voice, so that the direct action flows from the noun to the verb, and the sentence is shorter.  The passive voice is characterized by some form of the verb "to be."  
For example:
Preferred:  Two steps complete the enrollment.   (Active voice, 5 words)  

Not Preferred:  The enrollment can be completed with two steps.  (Passive voice, 9 words)

2.9 Document Flow

All modules will have a job aid. Most courses will be developed in the job aid/ walkthrough/practice format.  Each course will begin with a course overview, including course objectives, required prerequisites (if needed), its intended audience, and navigational instructions.  For view only, seldom-used, or specialized user population processes, a job aid may be all that is required.  
Each module will begin with a module overview, including the objectives of the module.  The modules will also include a walkthrough, which will outline a task-related scenario and the specific steps that the user will follow to accomplish the task, along with appropriate screen shots.  

After each walkthrough, there will be an practice exercise, including an appropriate business scenario containing the data necessary to completion of the task. This practice should include no prompts or instructions; the user should be able to complete the exercise using only the data from the scenario and the job aid.  
2.10 Starting and Ending Guidelines 

In each module, the module objectives should be preceded by the following sentence:  
After completing this module, you should be able to:

Step one of Walkthroughs should be worded and structured similar to the following, which indicates the breakout of the menu paths.

1. Begin at the Provider Search panel: 
Provider Tab > Search 
When instructing the users to navigate to another panel, use the following format.

15. Move to the Claims panel:  Click the Claims tab.

The final steps should be to save any changes (if applicable), and to close the panel.  This reinforces navigation features, orientates the user, and helps the Instructor by having everyone on the same panel.  Use the following format.

27. Save the information.

28. Click Home.
Use quotation marks around the data to be typed into fields.  Make sure to put your line period outside the quotations.  For example:

11. DEA:  Type “123-33-45789”. 

2.11 Exercises

The word SCENARIO: should appear preceding the Walkthrough and Practice scenarios. The phrase WHAT YOU NEED TO DO: should appear in the Exercise section after the scenario.  After the WHAT YOU NEED TO DO phrase, use a bulleted list for general directions. However, if you approach or exceed 5 bullets, try to group information into a header/general bullet, keeping the page uncluttered. For example:

	1.1 Exercise

	SCENARIO:

Provide a detailed scenario for users to practice the module objectives.  Include exact examples, but provide enough variation that would foster independent growth.

WHAT YOU NEED TO DO:

1. Dr. Johnson has a change of address for his payments.

2. Use a new effective date of xx/xx/xx

3. Etc.




2.12 Miscellaneous
· Use the highlighting tool to bookmark areas that will need further attention during development.  This will help prevent any internal notes from slipping by and being printed in the final documentation.
· When listing the steps required to perform a task, clarity is essential. The users must understand exactly what they are doing and why they are doing it. Terminology and styles must be consistent throughout all instruction.  
· A successful user guide for training should also function as a reference manual that will give users immediate access to the information they seek when they are doing their jobs. It is, therefore, important to focus on the steps to accomplish the task, not the context of the task.
· Avoid gender specific language.  Instead, refer to “users” or “you/your.”
· For example:  The user will….
     Your screen will appear…
3. Style Guide Specifics for E-learning Courses
3.1 Basics

This section refers to items that are specific to e-learning.  Developers should read and adhere to the standards that are detailed section 2.
Adobe Capitivate will be the software package used for creating all e-learning courses.
· To capture the simulation, set your screen resolution to 1024 x 768, which is the recommended resolution for use with the NewMMIS application.  Set your color quality 32 bit (highest):
· Start > Settings > Control Panel > Display > Settings

· When setting up Captivate to begin recording your simulation, make sure that the red sizing bar does not include any internet tool bars, such as the title, address, tool, and task bars; you should only capture the application screen itself.
· Follow the process storyboards closely when capturing the simulation. The screens of the simulation should look, feel, and function like the live system. Use the print screen button as needed when making your simulation to ensure that you have all the screen information that you need once you begin editing.
· For ease of editing, order your items on the timeline sequentially.

· Caption boxes should appear .50 seconds after the start of the slide as detailed in Section 3.7.

3.2 eLearning Component Overview

The following table provides a general overview of the components of a NewMMIS online course for the NewMMIS users:
	Name of Section
	Tool
	Content

	Introduction
	FrontPage
	· What are the prerequisites? 

· Who should take this course? Audience – course content

· What are the course objectives?

· How does this online training work? Description of the elements on the pages and how the courses work.

· How do I return to the eLearning home page? 

· What if I have questions? Getting help from the e-instructor

· “What’s Next” should list all of the modules pages within the course.

· Only the next module within the course should be hyperlinked.

· There should be no link or reference to the evaluation from the introduction.

· Periods at the end of each objective.

	Module Overview 
	FrontPage
	· Content overview of the specific module

· Module objectives

· Links to access: 

· Job aid related specifically to this module.

· Walkthrough simulation.

· Scenario to be used in Practice exercise.

· Practice simulation.

· Evaluation - confirm link is on the last module page.

· Job aid, walkthrough, practice, and scenario: 

· opens only in second window.

· JavaScript reflect (On Click) not mouse over or mouse down.

· Periods at the end of each objective.

	Job Aid 
	FrontPage
	· Not scenario-based

· Provides detailed, step-by-step info for completing each procedure (includes screen shots)

· Does not contain instructions related to using the simulation videos

· Can be used as stand-alone documents

· Created for all procedures

· Job aids contain the minimum number of screen shots - should be used as a guide.

· Steps are followed by screen shots.

· There is always a row before and after a screen shot.

· Check that each image has a border around it.

	Walkthrough 
	Captivate
	· Scenario-based

· As generic as possible to all branches

· Walks through all of the information on the job aid

· All information is contained within the video (in instruction boxes, etc.)—no need to print out a companion document

· Created for most procedures

· Confirm all “clicks,” links, and text entry fields are correct.

· Give complete narrative in the introduction so the user knows what to expect.
· Use the scenario bar to display the general scenario and include any “notes” specific to the page 
· More complicated simulations require information to be stepped, guided.

· Bold – Data typed in fields, field names, and targeted page elements (tabs, buttons, look-up icons).
· Use active voice.

· Any time you enter data, explain why you are entering the data. Example: Change “Enter member ID#  45674300012”   to  “Enter Lee’s employee ID#  45674300012”.

· Caption boxes

Confirm that: 

· text does not drop off the box – scroll will not work if box is too small.

· text box is not covering important fields/information (it may cover unwanted information.) 

· Split caption boxes that have too much information – add next button.

· Instruction box has explanation followed by a space followed by step.

· Screen captures: 

· gifs or .bmp not jpeg

· should be captured with Snag-it from Captivate simulation.

· Scroll bar:

· target is either at the top or bottom - not middle.

· When describing a page avoid “This is the…page” instead “This is the…page where you can…”



	Scenario 
	FrontPage
	· Provides the detailed information to be used in the practice simulation.
· Provides data needed to get through the simulation; doesn’t detail step-by-step instructions.
· Scenario Text: Add Statement when applicable:
”There is no scenario information or practice exercise for this module.”

	Practice 
	Captivate
	· Scenario-based

· Minimal pop-ups on the screen (only to point out what wouldn’t be obvious to the user)

· Do not need to be created for rarely used or view-only procedures.


3.3 Use of Next Buttons
For the introductory slides created in PowerPoint using the standard NewMMIS template, Next buttons must be inserted to allow users to move forward without using the playback bar. 
Next button settings are:

1. On success: Continue
2. Allow user: Infinite attempts
3. Type: Text button
4. Button text: Next

5. Keyboard shortcut: Alt+N

6. Display for: Rest of slide 
7. Appear after: 1 sec.

8. Pause movie after: 1.5 sec.
9. Click Apply
10. Click OK
Insert a button in lower right corner of each introductory page.
Next buttons should also be employed when there are greater than 4 sentences or 25 words total in a caption box on a slide. In these cases, the text should be split over two slides.

Insert a button in the bottom center of the caption box on the third slide.

Note: To ensure that Next buttons on caption boxes will appear when the simulation is published, right-click the button and select Bring to Front.

3.4 Use of Transparent Buttons
To accommodate all reading levels and to ensure that the simulation is self-paced, insert a transparent button on all walkthrough slides where there is no clickable navigational element, e.g., a button, drop-down, or look-up icon that is already covered by a transparent button. Insertion of a button will cause the screen to stop until clicked; otherwise, the simulation will play automatically, based on the timing in the Timeline bar.

Transparent button settings are:

1. On success: Go to next slide
2. Allow user: Infinite attempts

3. Button type: Transparent button

4. Frame color: White

5. Fill color: White

6. Keyboard shortcut: Alt+N

7. Display for: Rest of slide 

8. Appear after: 0.0 sec.

9. Pause movie until user clicks: Select the checkbox
10. Show hand cursor over “hit” area: Select the checkbox.

· Note: Select this option only for clickable navigational elements. Do not select this option for clicks in vertical or horizontal scroll areas. 

11. Click Apply

12. Click OK

Insert a button in the lower left corner of every walkthrough page that does contain a clickable navigational element..

3.5 Playback Control Bar

Insert a Playback Control bar for the readers to use to advance from slide to slide:
1. Simulation > Preferences.
2. Click on the Playback Control tab.

3. Position: Bottom Center.
4. Style: Captivate
5. Show progress bar: Select the checkbox.
Playback Control bar is placed at the bottom of every page for the user to advance from slide to slide.

You must include a navigational slide at the beginning of every course explaining how to use the Playback Control bar.

3.6 Highlight Boxes

Caption boxes are accessed by either using the Insert menu option, or by double clicking on the default highlight boxes included when the simulation is created.  The following conventions should be used:

· Frame color: Basic red, transparency is 0%

· Fill color: White, transparency of 100%.  

· Frame width: 2
· Display for: Rest of slide

· Appear after: 0.0 seconds
· Transition effect: No transition
· Apply properties to all highlight boxes in the simulation: Select the checkbox

3.7 Caption Boxes

Caption boxes are accessed by either using the Insert menu option, or by double clicking on the default caption boxes included when the simulation is created.  The following conventions should be used:

· Caption type: Yellow One
· Font: Verdana
· Font size: 14
· Text color: Basic blue
· Text is aligned left
· Display for: Rest of slide

· Appear after: 1.0 second

· Transition effect: Fade in only - .50 second

· Apply properties to all highlight boxes in the simulation: Select the checkbox

· Capital letters at the beginning and periods at the end of sentences
· The screen element name and type should be in bold, e.g., Provider tab, Search button.
Caption boxes should be displayed at the top center of each page so that the participant gets used to looking in the same place; however, ensure that the caption box is not covering fields or information necessary to the successful completion of the simulation..
Verbiage in the caption boxes should provide adequate guidance to the user, following the conventions explained in Section 2.6 and 2.7 of this document.
3.7.1 Timing for Caption Boxes
For any text boxes that require timing (Options | Display for: Specific Time), set display time to the equivalent rate of 180 words per minute (3 words per second).
· Example:  for a 21-word text box, the display time is 7.0 seconds.
Reasoning for this rate is due to review of two articles:  SpeedReading Onscreen: The Effects of Line Length on Performance by Dr. Bob Bailey, and The effects of line length on reading online news by A. Dawn Shaikh.

Per Bailey, the average adult reading speed is about 250-300 words per minute (wpm) and drops to about 180 wpm when reviewing (“proofreading”) text online.  Similarly, the results of a study by A Dawn Shaikh showed that college-age students read at a rate of 165-180 wpm when reading text online that they would later have to answers questions about.

3.8 Text Boxes

Text boxes are accessed by either using the Insert menu option, or by double clicking on the default text boxes included when the simulation is created.  The following conventions should be used:

· Since NewMMIS displays text typed in fields in all capitals upon validation, when the user must type in a text field, ensure that you include three versions of the data as acceptable:

· All caps

· All lower case 

· Initial cap
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· On success: Continue

· Allow user: Infinite attempts
· Display for: Rest of slide
· Appear after: 0.0 seconds 
· Pause after: 4.5 seconds
· Failure caption: Select the checkbox (walkthrough exercises only)
· Pause for failure/success captions: Select the checkbox (walkthrough exercises only)
· Failure Caption Properties:

· Caption type: Captivate red




· Font: Arial
· Size: 12

· Text: Please check your spelling and re-type the text.
· Display for: 2.0 seconds

· Effect: Fade in and fade out

· In: .50 second

· Out: .50 second
3.9 Timing and Timeline Setup

Slides should display for a minimum of 5 seconds. The transparent button detailed in Section 3.2 places an Active/Inactive segment on the timeline.  In general, the Active portion should be 4.50 seconds and the Inactive portion should be .50 second; however, there may be some cases when the slides must display longer, e.g., where there is extensive caption box verbiage, many fields on the panel, etc. Use your best judgment for timing in such cases.
If there is data entry required on a given frame, make sure that the typing begins and ends within the “Active” portion of the timeline so that all typing shows during the simulation.

3.10 Use of Exit Buttons
For the final slide of a simulation, an Exit button must be inserted to allow users to close the simulation window. 
Exit button settings are:

1. On success: Execute JavaScript

· javascript:window.close();
2. Allow user: Infinite attempts

3. Type: Text button

4. Button text: Exit

5. Keyboard shortcut: Alt+X

6. Display for: Rest of slide 

7. Appear after: 0.5 sec.

8. Pause movie after: 1.5 sec.

9. Click Apply

10. Click OK

Insert a button in the bottom center of the caption box on the last slide.
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3.11 eLearning Simulation Checklist
	Name of Section/ Tool
	Standards

	Introduction/ FrontPage
	· “What’s Next” should list all of the modules pages within the course.

· Only the next module should be hyperlinked.

· There should be no link or reference to the evaluation from the introduction.

· Periods at the end of each objective.

	Module Overview/

FrontPage
	· Tabs:

· text is aligned center.

· position of the layers is correct, no white space etc.

· Periods at the end of each objective.

· Scenario, job aid, and crosswalk: 

· opens only in second window.

· JavaScript reflect (On Click) not mouse over or mouse down.

· Evaluation - confirm link is on the last module page.

	Job Aid/

FrontPage
	· Job aids contain the minimum number of screen shots - should be used as a guide.

· Steps are followed by screen shots.

· There is always a row before and after a screen shot.

· Diagram information follows the diagrammed screen shot.

· Check that each image has a border around it.

	Walkthrough/ Captivate
	· Title/Objectives Frame:

· Text should read: “When you complete this Walkthrough you should be able to:”

· Intro Frame 1:

· 1st paragraph: inactive frame w/intro. Text should read:  “Welcome to the x Walkthrough.”

· 2nd paragraph: additional text explaining the purpose of this module (taken from job aid or module page) (generic).
· Next button.

· Intro Frame 2: complete narrative (so the user knows what to expect). 

· 1st paragraph: 1. Person, 2. Situation, 3. What the user is about to do.  (specific)

· 2nd paragraph:  “To navigate to the x component, follow this path: Provider > Search” (“Home” should not be included in this path)

· Next button.

· More complicated simulations (multiple navigations) require information to be stepped, guided (broad steps at the beginning of each navigation).

· Use active voice - avoid “you should” and “you need to.” Start sentences with an action verb. (Think - You must…)

· Confirm all “clicks” and text entry fields are correct.

· Use Bold for data typed in fields, field names, and targeted page elements (tabs, buttons, look-up icons).

· Any time you enter data, explain why you are entering the data. Example: Change “Enter member ID#  45674300012”   to  “Enter Lee’s employee ID#  45674300012”.
· Caption boxes 
Confirm that: 

· text does not drop off the box – scroll will not work if box is too small.

· caption box is not covering important fields/information (it may be covering unwanted information.) 

· Split caption boxes that have too much information – add next button and repeat the slide with the rest of the caption box information.

· Abbreviations & Acronyms: 1st time you use one of these, spell the full term out, then put abbreviation in parentheses. Use abbreviation from that point forward (e.g., “Third Party Liability (TPL)”, then “TPL”).

· After users press save, text should read: "Remember: You must save the information or your changes will be lost. The system will not prompt you to save.”
· Scroll bar:

· target is either at the top or bottom - not middle.

· click once on the down arrow to view the “bottom” of the page or up arrow to view the “top” of the  page.

· Screen captures: 

· .gif or .bmp not jpeg

· should be captured with Snag-it from Captivate

· When describing a page avoid “This is the…page” instead “This is the…page…you can..”

· Exit button.

· When there is no practice exercise for the module, the table row should be deleted from the module page.

	Scenario/ FrontPage
	· Scenario Text: Add Statement when applicable.
”There is no Scenario information or Practice exercise for this module.”

	Practice/

Captivate
	· Title/Objectives Frame:

· Text should read: “When you complete this Walkthrough you should be able to:”

· Intro Frame 1:

· 1st paragraph: inactive frame w/intro. Text should read:  “Welcome to the x Walkthrough.”

· Next buttons.

· Exit button.

· When there is no practice exercise for the module, the table row should be deleted from the module page.
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